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The Kongsberg C tooling system

The Kongsberg C tooling system consists of a wide variety of optional tool units. These
can be quickly mounted in the tool position.

There are three tool positions available, so you can use up to three tools on the same job.

1. Heavy-duty (HD) Tool Position for heavy-duty tools that are optimized for power

> Heavy-Duty Tool Unit
> Foam Cutting Unit
> High-Power Milling Unit

2. Fast Tool Position for knife tools optimized for speed

> Oscillating Knife Tools
> Static Knife Tools

> KissCutting Knife Tools
> Rotary Cutting Tools

3. Insert Position (optional) that accommodates inserts for either pen plotting or
drilling of holes

> Drill Tool Insert
> Ballpoint Pen Insert




Heavy-Duty Tool Unit

Sales code: 97AR5456

What is it used for?

The Heavy Duty Tool Unit offers the pos-
sibility to crease, V-notch and cut straight
lines at high speeds with a variety of adapt-
ers. This ensures superior performance
with heavy duty material such as double
wall, triple wall and recycled board, plus
the newest environmental boards.

It features 150mm (6") diameter crease
wheels with a scoring pressure equivalent to
50kg - 110lbs; sufficient to crease triple and
double-wall corrugated with heavy liners.

The large-size wheels also provide supe-
rior crease quality on recycled corrugated
board, especially because a higher pressure
can be applied without cracking the liner.

The HDU can offer V-notch cutting, with
mitered corners and extremely precise folds
for loading pallets, and container cushion-
ing pieces, and paper core board displays.

Materials

All sorts of corrugated boards up to triple
wall and including high recycled content,
fluted core board, honeycomb, corrugated
plastic, foam board.

Benefits

¢ 50kg -110lbs down force

e Powerful head rotation

» Large variation of V-notch tools (angles)
* HD knife tools

Included
HDU-C (Heavy-Duty Unit) tool package,
including

e Heavy duty tool unit

e Crease wheel, @150 4-point

e Crease wheel, @150 6-point

e (Crease wheel, U-shape @150

« Adapter for 26mm diameter wheels (w/o
crease wheels)

e 2p/26mm crease wheel

e 3p/26mm crease wheel

e 6p/26mm crease wheel




Foam Cutting Unit

Sales code: 97AR5458

The Foam Cutting Unit is a heavy duty tool
made for cutting a large range of foam
materials up to 50mm (2") thickness. These
types of foam are typically used in the pro-
tective packaging industry.

The FCU is a reciprocating knife designed
with characteristics optimal for low density
porous material. It works with a stroke length
of 4mm and a frequency of 4800 strokes
per minute. The great Z-axis control gives
an advantage when cutting foam because
it ensures consistent partial cut, which is
very important with many foam designs.

Support wheels safeguard the user from
the sharp blades and improve cutting abili-
ties by applying pressure on top of the
foam material.

Foam materials can normally be converted
at a speed up to about 15m/min with this
tool depending on material quality.

A wide range of blades also makes it suit-
able for honeycomb and fluted core board.

» Polyethylene foam; expanded polystyrene,
fluted core board, paper honeycomb
board.

* Please note that some foam materials
have a tendency to melt and stick to the
knife, also materials with open cells would
require additional hold down.

e Perfect for cutting a wide range of foam
materials at high speed

» Largerange of specially designed blades
for material versatility

* Supportwheels to hold the material down

There are two different adapters included,
one for up to 32mm (1 %4") material thick-
ness and one for up to 50mm (2") thickness.

The adapters accept the SR63xx and the
SR65xx style blades. Two blades of each
type are also included.

» Adapter for flat 40mm blades: 34014845
» See the Bits and Blades Catalogue for
more information.



High-Power Milling Unit (HPMU)

Sales code: 97AR5457

The High-Power Milling Unit allows for milling,
contour cutting, routing, drilling and engrav-
ing. It's suitable for high speed routing in
a wide range of materials such as foamed
PVS, solid PVC/PS, acrylic, aluminum com-
posite material (ACM), MDF, wood....

The 3kW milling spindle offers fast feed
rates, thus considerably widening the bot-
tleneck that routing jobs often present. The
spindle features a 3kW of milling power and
speeds up to 60,000 RPM. Itis liquid cooled
in order to utilize its full power potential.

The HPMU includes a software function to
supervise and monitor the spindle current,
which is useful to adjust the feed rate and
RPM settings for new materials.

Foamed PVC, solid PVC/PS, acrylic, alumi-
num composite material (ACM), MDF, wood...

The maximum material thickness that can
be milled is 50mm (2").

For milling thickness exceeding 25mm it
is beneficial to use milling bits with 8mm
shank size, used with an optional collet that
interchanges with the standard 6mm collet.

* High quality routing at high speed.

* High power, liquid cooled motor.

» Largerange of specialized and balanced
milling bits.

» Very fast milling bit exchange

Milling starter kit for 6 mm shank:

* 1Ix Acrylic, single flute, 3 mm tip, 11 mm
flute length

* IxAcrylic, single flute, 5 mm tip, 22 mm
flute length

* Ix Multi-purpose, 3 mm tip, 11 mm flute
length

* Ix Multi-purpose, 5 mm tip, 22 mm flute
length

» Felt Milling underlays: approx. 3mm thick

* (97AR5729) LubriCool misting Option -
see separate chapter.

» Optional collet shank sizes: 3mm, 8mm
see bits and blade catalogue.

* Non slip routing underlay - See online
shop



LubriCool Misting Option for HPMU

Sales code: 97AR5729

What is it used for?

LubriCool is an option for the High-Power
Milling Unit. It cools the milling bit and
lubricates the routing process. Resulting
in significantly higher productivity and an
extended life length of the milling bits for
materials such as Aluminum composite
Material (ACM) and some aluminum alloys.

The system is set up with a reservoir with
special “oil” that is converted into a mist with
help of compressed air and a mixing zone.

The mist is sprayed directly on the router
bitvia three nozzles during operation, only a
small drop off oil every 10 seconds is needed
(factory present). This small amount ensures
no trace on samples and low consumption.

The system can be turned off when routing
materials where misting is not beneficial.

Benefits

* Higher productivity (run faster with less
passes)

* Smoother routing surface, less after work

* Extended life length of router bits

Materials
Aluminum composite Material (ACM),
aluminum

Included
Routing liquid.

~ Partno:a41113s
Ser. no:2044
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Oscillating Knife Tools

VibraCut Knife Tool

Sales code: 97AR5464

This tool is suitable for single and double-
wall corrugated board and other light-duty
fibrous materials, such as corrugated board,
soft foam board and corrugated plastic.

It runs at a frequency of 6000 Strokes per
minute and with an amplitude of 0.3 mm.

These properties, along with a powerful
motor, enable cutting at full table speed
with good quality materials.

A floating foot is used to reduce material
tear and to keep the material down.

The cup is made of synthetic material to
avoid scratching of printed surfaces.

Maximum cutting thickness: 20mm - 3/8"-
3" depending on blade.

Different knife adapters allow for different
knife types. Maximum cutting thickness is
10-20mm - 3/8"-%" depending on blade.

Corrugated single wall, corrugated double
wall, micro flute, soft foam board, corru-
gated plastic.

* High Speed (full machine speed when
using good quality board)

» Cuts a wide range of porous materials

» Large range of high quality long life knife
blades.

» Adapter for SR6xxx blades includes 3 x
BLDSR-6223 and 3 x SR-BLD6224 knife
blades.

» A gliding foot for 20mm - 3/4" material
cutting thickness.

* (97AR931) Separate knife blade adapter
for SF216/217, including 4x BLD-SF216
and 4x BLD-SF217 blades

* Works with a wide range of blades, see
the Bits and Blades Catalogue.



High-frequency VibraCut Knife Tool

Sales code: 97AR5463

The High-frequency VibraCut Knife Tool is a
high-frequency reciprocating knife tool for
cutting a lot of different materials, such as
corrugated board with high-recycled con-
tent, soft foam board, corrugated plastic
and fluted core board.

It runs at a frequency of 12000 strokes per
minute and amplitude of 1.2 mm.

These properties, along with a powerful
motor, enable cutting of heavily recycled
board at efficient speed.

A floating foot is used to reduce material
tear and to keep the material down.

Corrugated material with high recycled con-
tent, fluted core board, Honeycomb board,
soft foam board, corrugated plastic, high
density foam.

Maximum cutting thickness: 20mm - 3/4"
with short foot, 30mm - 11/4" with long foot.

» Multi-purpose reciprocating knife toaol
for heavy duty board.

* Good performance with high recycled
content board.

e Large range of knife blades.

» Adapter for SR6xxx blades, incl 3x BLD-
SR6223,3x BLD-SR6224, 3x BLD-SR6310
and 3x BLD-SR6303 knife blades

e Gliding foot for 20mm - 3/4” material
cutting thickness.

e (97AR931) Separate knife blade adapter
for SF216/217, including 4x BLD-SF216
and 4x BLD-SF217 blades

* (97AR5148) Gliding foot for 30mm - 11/4"
material cutting thickness.

e Works with a wide range of bits and
blades, see Bits and Blades Catalogue.



Static Knife Tools

CorruSpeed Tool

Sales code: 97AR5731

The CorruSpeed Tool is developed for cutting
corrugated board at high speeds without
oscillating. The CorruSpeed Tool achieves
significant time savings on many corrugated
boards, even with recycled content.

The CorruSpeed operates with a crushing
cup, which in combination with controlled
down pressure makes it possible to use
a drag knife without tearing or cracking
the liner.

Setting up the tool for different board quali-
ties is easily done with help from adjust-
ment wheels / knob.

The tool also comes with two edge crush-
ing cups, radius 16 and 14,5 where the 14,5
gives more pre-crush.

Which cup to use depends on the thickness
and quality of the corrugated board. The
feet are easy to change; they are guided by
pins and magnets and snap in place easily.

The CorruSpeed Tool is designed to work
with corrugated board up to double wall
BC flutes (7mm).

» High productivity (in many cases the full
machine speed: 100m/min)

» Silent, the only noise you hear is the
machine movement.

* Smooth cut, the tools doesn't oscillate,
so that means no tagged edge

* Pre crushed lines: cutting lines are more
similar to a die cut

» i-PC 2.0 or higher is required.

» For corrugated board with extremely
short fibers and high recycled content,
you might still need the properties of
high frequency knife tools.

» 2xcrushing cups, with radius 16 and 14,5

* 8standard knife blades: 2x BLD-SR8170,
2x BLD-SR8172 2, BLD-DR8160 and 2x
BLDDR8180

Works with the SR/DR 8XXX blades, see the
Bits and Blades Catalogue.



Rigid Material Knife Tool

Sales code: 97AR5460

The Rigid Material Knife Tool is a static knife
tool suitable for a wide range of materials
at high speed. There is a large selection of
knife blades available that makes it pos-
sible to cut everything from light weight
detailed work to heavy rigid board like
plastic foamed PVC 3mm.

The maximum cutting depth is defined by
the blades; maximum thickness is 13 mm
/ Y2 inch.

Flexible plastic sheets, foamed PVC up
to 3mm, triple wall corrugated, soft foam
board, corrugated plastic, cardboard, dis-
play board, vinyl, PVC banner.

* Aflexible all around knife tool, used for
a wide range of applications

» Rigid board cutting at high speed

* High quality specially developed blades

2 x BLD-DR8160, 2 x BLD-DR8180, 2x BLD-
SR8170, 2x BLD-SR8172

* Works with all Kongsberg knife blades
in the BLD-SR/DR8xxx series, including
asymmetric blades for burr-free edges.

» Crease blades

11



Psaligraphy Knife Tool

Sales code: 97AR5730

What is it used for?

The Psaligraphy Knife Tool is specifically
developed for fine details in thin materi-
als like paper and folding carton. This is
archived by a spring loaded floating plastic
foot in combination with special designed
knife blades.

This tool is typically used for applications
like greeting cards, invitation cards, pro-
motional items, folding carton samples and
psaligraphy art.

Material
Fine detailed paper cut, folding carton

Benefits

e Cutsoutintricate details without lifting,
moving or tearing the material.

* High quality specially designed knife
blades with long life.

» User friendly plastic foot that snaps in
place guided by pins and magnets

Please note
i-PC 2.0 or higher is required.

Included
2x BLD-SR6150 and 2x BLD-SR6157 round
shaft cutting blades.

Optional

Works well with all Kongsberg knife blades in
the BLD-SR/DR61xx series including asym-
metric blades for burr-free edges.



HiForce Knife Tool

Sales code: 97AR5461

The Hi-Force knife tool is a general purpose
knife tool, suitable for cutting a wide range
of flexible, paper based and rigid materials.

The high down force is achieved by directly
using the machine Z-axis, which allows for
cutting intricate details in tough materials.
To reduce material tearing and keep the
material down, a floating foot is available.

The maximum cutting depth is defined by
the blades, with standard adapter maximum
thickness is 3mm / 1/8 inch.

Different knife adapters allow for different
knife types, see options.

Flexible plastic sheets, folding carton, dis-
play board, vinyl, PVC banner, corrugated
plastic.

» Aflexible all around knife tool
* High down force
* Wide range of adapters and blades

Adapter for SF blades, incl. 4x BLD-SF216
and 4x BLD-SF217 blades.

* (97AR452) Separate knife blade adapter
for half-length BLD-DF112/113 including
2x BLD-DF112 and 2x BLD-DF113 blade.

¢ (97AR50117) Separate blade adapter for
the DR/SR61xx-series including 2x BLD-
DR6160 and 2x BLD- DR6161 blade.

* Works with a wide range of Kongsberg
knife blades in the BLD-SR/DR6xXX,
DF112/113, SF216/217 series including
asymmetric blades for burr-free edges.

13



KissCutting Knife Tools
PressCut Knife Tool

Sales code: 97AR5462

14
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The PressCut Knife Tool is a specialty tool
for kiss cutting adhesive vinyl (decals) and
foils. It's used for applications where it is
important to keep the backing intact and
only cut through the top film.

Due to the characteristics of the material,
a spring loaded pressure is required in
order to achieve perfect peal/weed quality.

The pressure is software controlled, allow-
ing partial cut and through cut with same
tool. It has an extremely fast-response on
tool up/down movements.

The tool also features a software function
that enables speed dependent tool pres-
sure control, which is important to ensure
reliable cutting when velocity ramps up
and down.

Maximum downward knife pressure is T0N.

&
O

I
A

A

Adhesive vinyl (decals), foil, diamond grade
foil

» Perfect weeding/pealing quality at high
speed

» Tool pressure can be changed between
kiss cutting and through cutting.

» Onlythe knife blade touches the material;
i.e. no scratching of shiny or printed
surfaces

* incl. 3x KC101 and 3x KC102 knife blades
» Afoot for accurate depth control when
more pressure is required.

Kongsberg knife blades in the BLD-KCxx
series



Rotary Cutting Tools

RotaCut Tool

Sales code: 97AR5459

The RotaCut Tool is specifically developed
for cutting textiles, canvas, mesh and other
air transparent materials.

Since most textiles are more or less air
transparent the vacuum hold-down system
of the table will not be effective when cut-
ting such materials. The RotaCut Tool has
been designed with this in mind.

It operates by rotating a 10-facetted knife
blade at 10 000 RPM. The blade protrudes
from a slotin a hold-down foot that presses
down on the material. The foot is made from
a material that reduces friction to a mini-
mum, and these properties, in connection
with the fibrous surface of the conveyor
belt, or felt mats; provide a hold-down suf-
ficient for cutting most textile materials.

Maximum cutting depth is 2 mm/0.07 inch.

Textile, banner, canvas, mesh, carpet

* Floating foot for material hold
* High speed 10-facetted knife blade
» Software controlled overcut function

5x RC110 decagonal knife blades and tools
for blade change.

Applicable knife blades RC10 decagonal
knife blade.

15



Tools for the Insert Position

Tool Insert Fixture

Sales code: 97AR5030

What is it used for?

The Tool Insert Fixture is an optional tool
position and a prerequisite for the mounting
tool inserts; the Ballpoint Pen Tool, Fiber
Tip Pen Tool and the Drill Tool.

16



Ballpoint Pen Insert

Sales code: 97AR5031

What is it used for?

The Ballpoint Pen Tool is aimed for pen
drawing, plotting and sample marking on
materials such as folding carton, paper,
cardboard and other paper based materials.

Please note

The Ballpoint Pen Insert mounts into the
Tool Insert Fixture, which is an optimal tool
position. (97AR5030)

Included
2x pen refills; black, medium line weight.

Options

Refill pen, see the Bits and Blades Catalogue.

17



Fiber Tip Pen Tool

Sales code: 97AR5370

What is it used for?

The Fiber Tip Tool option provides draw-
ing capabilities on materials such as clear
vinyl, which normally cannot be marked
with ballpoint or liquid ink pens.

Please note
The Fiber Tip Pen tool mounts into the Tool
Insert Fixture, which is an optimal tool posi-
tion. (97AR5030).

Included
8 multi-colored pen refills, medium line
weight.

Options
Refill pen medium and thin line weight; see
the Bits and Blades Catalogue.



Drill Tool Insert

Sales code: 97AR5032

What is it used for?

The drill tool is aimed at light-duty drill-
ing in materials such as fluted core board,
honeycomb, soft foam board and triple wall
corrugated. Mounting and creating fixations
holes are the main applications. This tool
has a 70W geared motor and spins with
approximately 1000 rpm.

The adjustable chuck accepts drill bits rang-
ing from 0.5 - 6.5mm, or 1/64" - %".

Please note
The drill tool Insert mounts into the Tool
Insert Fixture, which is an optimal tool posi-
tion. (97AR5030).

Material
Fluted core board, honeycomb, soft foam
board and triple wall corrugated

Included
2x3mm and 2x 4mm drill bits are included.

19



HD Knife 17

Sales code: 97AR379

What is it used for?

Heavy-duty knife tool used for rigid board
such as fluted core board, display board and
triple wall material for fast straight cutting.
Maximum cutting thickness is 177mm. Lim-
ited to straight lines longer than 50mm (2").

Material
Fluted core board, triple wall, Honeycomb
board.

Benefits
Straight rigid panel cutting at high speeds.

Included
5x BLD-TZ129



HD Knife 30

Sales code: 97AR725

What is it used for?

Heavy-duty knife tool used for fast straight
cutting of rigid board such as fluted core
board and honeycomb board material. The
maximum cutting thickness is 30mm. Lim-
ited to straight lines longer than 50mm (2").

Material
Fluted core board, triple wall, Honeycomb
board

Benefits
Straight rigid panel cutting at high speeds.

Included
2x BLD-TZ230, a specially designed, Tung-
sten Carbide knife blade.

21



V-notch Knife 45°

Sales code: 97AR620

What is it used for?

For 45° V-notch cutting in triple wall cor-
rugated, corrugated plastic and fluted core
board. Its application is to make a 90° par-
tially cut V-notch for folding functionality or
a through-cut leaving a slanted cutting edge.

Max. cutting depth is 16mm - .590". Lim-
ited to straight lines only.

22

Material
Fluted core board, honeycomb board, soft
foam board and triple wall corrugated.

Benefits

e Perfect 45° slanted folding lines up to
16 mm material

e Specially designed high quality knife
blades

Included
2% BLD-TZ511 5x BLD-TZ192



V-notch Knife 45° 10mm

Sales code: 97AR274

What is it used for?
For 45° V-notch cutting for tougher materi-
als like corrugated plastic.

Its application is to make a 90° partially
cut V-notch for folding functionality or a
through-cut leaving a slanted cutting edge.

The maximum cutting depth is 10mm -
7/8". This will provide a more accurate cut
in thinner material due to the shorter free
end of the blade which gives less flex.

Max. cutting depth is 10mm - .590". Lim-
ited to straight lines only.

Benefits

» Perfect 45° slanted folding lines up to
10 mm material

» Specially designed high quality knife
blades

Material
Fluted core board, honeycomb board, soft
foam board and triple wall corrugated.

Included
2x BLD-TZ511 5x BLD-TZ192
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V-notch Knife 15°

Sales code 97AR982

What is it used for?

For 15° V-notch cutting in triple wall cor-
rugated, corrugated plastic and fluted core
board. Its application is to make a 30° par-
tially cut V-notch for folding functional-
ity, such as 12-edge polygonal pillars or a
through-cut leaving a slanted cutting edge.

Max. cutting depth is 16 mm - .590". Lim-
ited to straight lines only.

Material
Fluted core board, honeycomb board, soft
foam board and triple wall corrugated.

Benefits

o Perfect 15° slanted folding lines up to
16 mm material

e Specially designed high quality knife
blades

Included
2x BLD-TZ511 5x BLD-TZ192



V-notch Knife 22.5°

Sales code 97A5763

What is it used for?

For 22.5° V-notch cutting in triple wall cor-
rugated, corrugated plastic and fluted core
board.

Its application is to make a 45° partially
cut V-notch for folding functionality, for
products such as octagonal pillars, or a
through-cut leaving a slanted cutting edge.

The maximum cutting depth is 16 mm -
.590". Limited to straight lines only.

Please note
This tool can only be used on Kongsberg
cutting tables with iPC2.0 or higher.

Material
Fluted core board, honeycomb board, soft
foam board and triple wall corrugated.

Benefits

e Perfect22,5° slanted folding lines up to
16 mm material.

» Specially designed high quality knife
blades.

Included
2x BLD-TZ511 5x BLD-TZ192
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V-notch knife 30°

Sales code: 97AR983

What is it used for?

For 30° V-notch cutting in triple wall cor-
rugated, corrugated plastic and fluted core
board. Its application is to make a 60° par-
tially cut V-notch for folding functional-
ity, such as 6-edge polygonal pillars or a
through-cut leaving a slanted cutting edge.

The maximum cutting depth is 16 mm -
.590". Limited to straight lines only.

Material
Fluted core board, honeycomb board, soft
foam board and triple wall corrugated.

Benefits

» Perfect 30° slanted folding lines up to
16 mm material

» Specially designed high quality knife
blades.

Included
2x BLD-TZ511 5x BLD-TZ192




Crease Adapter 15mm

Sales code: 97AR101

What is it used for?

An adapter for using crease wheels with
diameter 15mm is available as an optional
crease tool to improve folding quality in thin
materials. The application of this adapter
is mainly folding carton and paper.

Benefits

» Use 15mm crease wheel in combination
with high down force.

» Creasing in thin materials

Material
Paper and folding carton

Included
Adapter only

Options

All 15mm crease wheels

27



Crease Adapter 26mm

Sales code: 97AR100

What is it used for?

An adapter for crease wheels with diameter
26mm is available as an optional crease tool.
The application of this adapter is to enable a
smaller sized wheel for micro flutes, folding
carton and corrugated plastic. The smaller
wheels and the heavy crease power, has a
good effect on defeating the ‘memory’ of
the plastic material.

Benefits

e Use 26mm crease wheel in combination
with high down force.

e Creasing in tough plastic materials

28

Material
Corrugated single wall, micro well, corru-
gated plastic, folding carton

Included
Adapter only

Options

All 26mm crease wheels




60mm Crease Adapter Whee|

Sales code: 97AR5588

What is it used for?

The 60mm Crease Wheel adapter offers
the possibility to crease most corrugated
thicknesses.

The medium-size wheels also allow for creas-
ing with a higher pressure without cracking
the liner, and with a limited over-crease.

It gives a sharper result to the 150mm
crease and at the same time allows harder
pressure than the smaller wheel diameters.

The optional 60mm Perforation Wheel pack
offers the possibility to produce tear per-
forations at high speeds for corrugated
board up to C flute (4mm).

Benefits

e Enables high speed perforation wheel

cutting
* Enables High pressure, medium crease

overcut

Material
Corrugated single wall, corrugated double
wall, micro flute

Included
Adapter only

Options
(97AR5517) 60mm Perforation Wheel pack-
For high speed perforation

Includes Perforation Wheel holder and four
standard perforation patterns , 3x3mm,
5x5mm, 7x5mm, 10x10mm.

Please note: there is no software control
on the wheel rotation, it is not possible to
control how the peroration line starts, i.e.

- with a cut or with a space.

* a4-point wheel suitable for E-and Micro
Flutes

* a6-pointwheel suitable for B- and CGflute

e U-shaped wheel for Double Wall
Corrugated

29



Crease Blade Adapter

Sales code: 97AR5307

30

What is it used for?
Crease blades are typically used for creasing
flexible plastic sheets such as polypropylene.

With this type of material a blunt blade will
give better folding capabilities than what
can be achieved with a crease wheel.

The adapter also accepts BLD-DF2xx blades,
typically used together with the PressCut
tool.

Benefits
Creasing in tough flexible materials

Material
Flexible plastic sheets, polypropylene

Included

¢ (Crease blades adapter
¢ 0.5mm crease blade

¢ 1.0mm crease blade.

Options
BLD-DF212 and BLD-DF213 knife blades,
for through-cutting of simple shapes..
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For more information

about the various tools you can contact us at

info.eur@esko.com.

Order your

bits and blades
online

Visit the Esko Store to buy the best bits and
blades for your Kengsberg cutting table.
www.esko.com/store
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